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Introduction

Overview

FreeFlow® Accxes® Indexer and FreeFlow® Accxes® Copy software applications provide an easy-to-
use workflow augmentation to Accxes. Accxes Indexer provides viewing, indexing, and document
archiving capabilities, while Accxes Copy is used primarily for color and monochrome copying/scanning
to a variety of devices including non-Accxes supported devices.

Accxes Indexer/Accxes Copy provide a productive method of scanning when used in conjunction with
the scanner. This is achieved without the need for a dedicated PC; instead, the system provides
scanning that can be shared across the network.

This guide provides detailed information and instructions for setting up and using both the Accxes
Indexer and Accxes Copy applications.

License server information

A license server is used to support the needs of Accxes Indexer and Accxes Copy clients. The license
server also supports Accxes Indexer and Accxes Copy multi-user license packs. The license server
automatically starts at boot and stops automatically if no multi-user licenses are installed.

The license server provides the following:

e Automatically starts the service (if user permissions are set for this); otherwise, the service must be
manually started from the Control Panel, Administration Tool Services.

e If Accxes Indexer starts and no licenses are available on the server, Accxes Indexer will wait for an
available license.

e Adetails button on the About window provides client information on the licenses that are
currently in use.

e If the connection to the license server is interrupted, Accxes Indexer pauses with a Connection to
license server lost screen; the license server attempts to reconnect. The user may click Cancel to
quit.
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Accxes Indexer

Accxes Indexer overview

The Accxes Indexer application is easily customized to meet many specific requirements:

The default/initial view can be configured to automatically show the whole image, or for most
images, it can be zoomed to a title block corner.

Images can be indexed with various naming conventions and sorted into specific or custom
directory structures.

Accxes Indexer supports many common file formats; refer to Appendix C on page C-1.

Note

You will need Adobe® Acrobat® Reader™ to view PDF® documents. Download a free copy from
the Adobe Web Site http://get.adobe.com/reader/.

Post-processing options can be implemented to add additional functions, such as converting the
indexed image to other formats or automatically importing to a document management system.

Configuration settings can be password protected to ensure indexing is performed as required by
the Administrator.

Accxes Indexer incorporates simple editing tasks such as crop, despeckle, and deskew. The
software can also be configured to use a third-party Raster Editor in order to make further
advanced changes to images prior to completing the indexing task.

Once configured, images can be indexed quickly and without the need for any movements of a
mouse.

The quality of a scanned image is quickly and easily evaluated.

Sample (check) prints can be obtained from Accxes-based Xerox Wide Format printers to clarify
any uncertainty in the quality of the scanned image.

Rejected scans can be identified with a customized menu to identify the reason for rejection.
A log file can be created to record all scanned images in a comma-delimited format. Formats can
be used by third-party applications, such as Microsoft® Excel®.

Various profiles can be set-up so that Accxes Indexer can be customized to satisfy multiple user
requirements and differing indexing processes.

Please refer to the Xerox Wide Format FreeFlow Accxes Indexer/Accxes Copy Installation Guide for
complete information and instructions on System Requirements, Licensing, and Installation.

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy 2-1
User Guide


http://get.adobe.com/reader/

Accxes Indexer

Accxes Indexer quick setup procedure

The following information provides instructions for quickly setting up the Accxes Indexer application;
this enables you to quickly and easily begin using the Accxes Indexer application. For more detailed
information on each of the Accxes Indexer features and options, refer to Indexing window on page 2-

5.

To quickly setup your Accxes Indexer application, perform the following steps:

1.

2-2

Launch the Accxes Indexer application at the PC by selecting Start > Programs > Xerox >Xerox
Wide Format> Xerox FreeFlow Accxes Indexer.

The Accxes Indexer main window is displayed.
Note

The first time that the Accxes Indexer application is used, you are asked for license information. If
necessary, license the application by following the instructions provided in the Xerox Wide Format
FreeFlow Accxes Indexer/FreeFlow Accxes Copy Installation Guide.

Select Settings > Configure.

Select the [Source] tab.

This feature sets the default the location from where the Accxes Indexer obtains images. This
feature also allows you to setup the viewing and indexing defaults.

Select the [Destination] tab.

This option allows you to configure the location from which the Accxes Indexer will store images.
These images can be obtained either from a file or directly from the Xerox Wide Format Scan
System.

Note

For the purpose of this procedure, it is assumed that images are obtained from the Xerox Wide
Format Scan System.

Scan a document to the default “images” mailbox of the Xerox Wide Format Scan System.
Select the radio button for Accxes.

a. Inthe address field, enter the TCP/IP address of the scanner controller (Accxes).

b. Inthe Directory field, enter the desired directory; for example “images.”

The information entered here must EXACTLY match whatever the chosen directory is when
entering scan mode on the scanner. This field is case sensitive.

c. Select the Enable Polling Every field and enter the desired value.
The default value is 5 seconds.

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy
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10.

11.

Accxes Indexer

Select the [Destination] tab.

a. Use the browse button to create and select the folder destination for the indexed scanned
images.

b. If desired, select the check box for Save On Reject. This will save any rejected scans for later
resolution.
Select and create a folder destination for reject scans.

Select the [Initial View] tab.

a. Select the radio button for Bottom Right.

b. Inthe zoom field, select the down button to display the zoom value: 4:5.

This determines the position and size of the title block in the viewer and works best if all
documents are scanned long edge first and with the title block trailing. Images larger than 23.39 x
33.11 in./A1/Arch D must be rotated within Accxes Indexer.

Select the [Index Fields] tab.

a. Use the Number of Fields spin-box and create the desired number of fields; for example 3:
e  Project number
e  Drawing number
e Revision number

b. Inthe Name field, enter the desired name (such as Project number). Repeat this for each of
the created Index Fields (for example: Drawing number; Revision number).

¢. If scans are saved to a subfolder of the default destination folder, then in the Separator field,
enter the desired separator, such as a backslash (\).

A backslash means a directory will be created as part of the indexing process.
Note
Do not enter any extra spaces.

d. For the Style field, select the desired style from the pull-down menu, such as Keep or Forget.
Select the [Reasons] tab.

a. Use the Number of Reasons spin-box to create a number of reasons for all rejected scans. A
field appears for each of the selected reason numbers.

b. Enter a different reason in each field. During the indexing process, this produces a pull-down
field listing the previously-entered reasons.

Select the [Advanced] tab.
a. Select the Enable Editor check box if you have a third-party Raster Editor installed on your PC.

b. Inthe Path field, browse to the executable file that is used to start the Raster Editor; for
example, C:\Program Files\Editorname\Editorname.exe.

¢. Select the Enable Printer check box if you have an Accxes-based printer with your scanner.

Edit the code line to change AccxesAddr to the TCP/IP address of your printer; for example,
Ipr-$10.1.5.21 -Praw

d. Select the Enable Reporting check box.
In the File field, browse to and select a location to store the log file.
f.  Inthe Select a Report File window, enter a name; for example, gilog.csv

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy 2-3
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12. At the bottom of the Settings window, type a profile name to save all the settings.
13. Select [Savel].

14. Select [OK].

15. From the Accxes Indexer main window, select [Profile].

Select the profile (same as entered in Step 12). A scanned image appears in the Accxes Indexer
Viewer.

16. In the [Project Number] field, enter the relevant number.
a. Use either the [Tab] or [Enter] key to move to the next field.
b. Inthe next field, enter the drawing number as viewed in the image.
c. Inthe revision field, enter the relevant revision number or letter.
17. Press the Accept or enter/return key on the PC keyboard.
e  You are asked to confirm the creation of the directory named under the Project Number.
e  Confirm this and the renamed image is automatically saved to the created directory.

Note

Detailed information on viewing tools is provided in the section entitled Indexing window on
page 2-5.

Using Accxes Indexer as a viewer

Accxes Indexer can be used as a viewer of compatible files. During the indexing process, files can be
named and saved with an extension that can be associated with Accxes Indexer. These files can be
opened with Accxes Indexer for viewing purposes.

The following information provides instructions on how to use Windows® Explorer to configure Accxes
Indexer as a viewer.

Using Windows Explorer to configure Accxes Indexer as a viewer

18. Launch Windows Explorer.
19. Select Tools > Folder Options.
20. Select [File Types].

21. Select [New].

22. Inthe [File Extension] field (in the Create New Extension window), enter an arbitrary file
extension such as qndx.

This is the file extension that will be associated with the Accxes Indexer Viewer.
23. Select [OK].
24. Inthe Registered file types listing, select the gndx entry and select the Advanced button.
25. Type QI Viewer in the [Change Icon] field.
26. Select the Change Icon button.
27. Browse to C:\Program Files\Xerox\Wide Format\Xerox Wide Format FreeFlow Accxes Indexer.
28. Select Indexer.exe.

2-4 Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy
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29. Select [OK].

30. Select the New button.

31. Inthe New Action window, enter open in the Action field.

32. Select the Browse button.

33. Browse to C:\Program Files\Xerox\Wide Format\Xerox Wide Format FreeFlow Accxes Indexer.
34. Select Indexer.exe.

35. Add a space by pressing the space key on the computer’s keyboard, and then enter -f%1 at the end
of the command.

36. Select OK from the New Action window.
37. Select OK (from Edit File Type).

38. Perform an indexing function, and during the indexing process, save a file with the gqndx
extension.

39. Locate that saved *.qndx file and double click on it.
The Accxes Indexer opens and the file is displayed.

Note

The Settings and Profile menus are hidden when Accxes Indexer is used as a “Viewer.”

Indexing window

Overview

The indexing window is where the user performs the following functions:
e View the scanned image

e Enter the indexing information for the scanned image

e  Accept the scanned image

e Reject the scanned image

e Simple editing

e Launch a third-party raster editor (if available)

e  Produce check prints on a Xerox Wide Format Accxes-based device.

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy 2-5
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The image is viewed and indexed according to the customized settings selected in the Settings menu.

BZ Accxes Indexer
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When Accxes Indexer is started, the status bar at the bottom asks the user to select a profile. First
maximize the Accxes Indexer window in order to increase the magnification of the scanned image for
viewing.

Assuming a profile was previously created, select [Profile] at the top of the window and select the
required profile. Accxes Indexer loads the profile options and starts checking for scanned images. The
indexing process may then begin.

The task bar at the bottom of the main window provides additional information regarding the number
of waiting drawings, page number being viewed of a multi-page document, file format, color and size.

Indexing the displayed image

When an image is displayed and no other functions in the toolbar have been selected, the cursor will be
flashing in the first indexing field. The user can begin to type the indexing information and tab to the
other indexing fields. Drop down fields allow the user to select previously entered values, where
permitted by the index settings. The grayed-out field displayed alongside Filename, shows the path
and name being applied to the image during the indexing process.

The illustration on the previous page shows three example fields in use: Project Number, Drawing
Number and Revision. In this example, the indexed file will be saved in a directory listed or created in
the Project Number field. The two fields called Drawing Number and Revision are being used to apply a
single filename, separated by a hyphen.

After all the indexing fields have been entered, pressing the Enter/Return key on the PC keyboard, or by
selecting [Accept] in the Accxes Indexer indexing window will complete the indexing process for the
currently selected image. The image will disappear from view, the file will move to the destination set-
up in the Settings menu and the next image (if there is one) will automatically be displayed.

2-6 Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy
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The indexing fields can be customized to fulfill individual requirements for the indexing process. For full
information, consult the section in this guide entitled: Index Fields Tab.

Using the Image toolbar

The default view of the scanned image is Lower Right with a zoom factor of 4.5 (best for most title
block positions). Universal tools are available in the Indexing window to navigate around the scanned
image and provide simple editing. Some of the less common tools are as follows:

Icon Symbol Description

Print - used to product a check print of the currently viewed image. Configure the printer as
‘-é described in the section entitled Advanced Tab.

Note: The printer button will not be available if a scanned image was produced with
preview enabled. Refer to Appendix B on page B-1 for more details on the preview mode.

EMail - used with Outlook express only. Selecting this icon opens an email message with
the current document attached.

%

Undo - used to undo (erase) editing functions; this restores the drawing to its original state
and removes all previously-performed editing steps.

Crop - used for cropping an image to the selection made with the selection tool

Copy - used to copy (duplicate) part of the image into another application. The required
part of the image to be coped is selected using the selection tool.

Navigation Tool - used to pan around the image

N AN

Selection Tool - used to make selections in the image for cropping and copying. The
mouse is used to select, drag and then release around the required selection. When
cropping, the area outside the selection is removed. When copying, the area inside the
selection is copied.

I

Zoom In/Zoom Out - used to zoom and out of the image. The left and right mouse
= buttons also perform these functions. To zoom to a specific area, hold down the left mouse
& S :
button and drag the mouse around the required area and release.

Zoom Title Block - used to automatically zoom to the Tile block as configured in the Initial

LTIIE" View Tab in the Accxes Indexer settings window.
Zoom to Fit Window - used to view the entire image. On a three-button or wheel mouse,
i+ the The middle mouse button also performs this function.
+

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy 2-7
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Icon Symbol Description

Rotation Left and Right 90° - used to rotate the image for viewing in the correct
o ek orientation. For example, an AO must be scanned in a portrait orientation. The rotation
tools are used to rotate the image into a landscape orientation.

Note: When the image is indexed, you will be prompted to save any rotation. The rotate
buttons will not be available if the image was scanned in preview mode. Refer to Appendix
B on page B-1 for more details on preview mode.

Mirror - Use this option to reverse the original image creating a mirror of the original.

Despeckle - Use this option to smooths areas of the image in which noise is noticeable
while leaving complex areas untouched. The effect is that grain or other noise is reduced
- without severely affecting edges. Despeckle is not available for PDF, PostScript, or HPGL
documents.

Automatic Deskew — used to automatically straighten an image. This is dependent upon
the amount of skew and the quality of the skewed lines. Automatic Deskew is available
@ only for 1-bit (monochrome) raster documents such as TIFF and CALS.

Manual Deskew - used to manually straighten the image. With the tool selected, the

mouse is used to draw a line parallel to the skewed line that needs to be made horizontal.
ﬂ The line is drawn with the mouse by selecting and holding down the left mouse button,
draw the line by moving the mouse along the skewed line and then release the mouse. The
deskew will then be performed automatically. Manual Deskew is not available for PDF,
PostScript, or HPGL documents.

Extract Detail (Only available if viewing a gray scale image) — used to extract detail from
E the scanned image. Refer to the illustration on the next page for details. If used on color
images, Extract Detail functions as a black/white point adjustment tool.

Crop White Space - used to automatically crop (trim) the white space surrounding a
|§ scanned image.

Scroll Arrows - used to scroll through a multi-page document.

<L
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With the Exact Detail tool selected, the following window opens:

Black Paint

[ e — o

"hite Point

T | [255
0K | Eancel .................

This tool is specifically designed for use with images scanned using the 8-bit gray scale Photo Mode.
Using the above window, background can be removed and foreground enhanced and vice versa by
using the two sliders.

Original Grayscale Foreground Extracted Background Extracted

Rejecting a displayed image

If the user wishes to reject the scanned image, select the reject button in the Accxes Indexer indexing
window. The image will be deleted or saved to a reject folder if this was configured during the set-up of
the indexing profile.

If Keep On Reject is enabled, the image will be saved to the reject folder as set-up in the section
entitled: Destination Tab. If enabled, a drop down list is displayed for the user to select one of the
reasons for rejecting the scanned image. The drop down list can be enabled and customized as
described in the section entitled: Reasons Tab.

The reason for rejecting the scanned image will be listed in the log file (if configured), together with
the name of the scanned image (information on the log file is described in the section entitled:
Advanced Tab).
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Advanced editing

Accxes Indexer can be configured to use some third-party raster editors to make use of advanced
editing functions. Information on configuring this is described in the section entitled: Advanced Tab.

When an image is viewed in the Accxes Indexer indexing window, the user can edit the image by
pressing the [Edit] button. (The Edit button will only be displayed in the Accxes Indexer indexing
window if a third-party Raster Editor has been selected.)

The image will be opened within the raster editor in order to make changes. To return to the Accxes
Indexer indexing window, the user must close the raster editor and save when prompted. The saved
image will then be viewed in the Accxes Indexer indexing window, allowing indexing to be completed
with the edited file.

Note

The edit button is not available in preview mode. See Configuring the Xerox Wide Format Scan
System for use with Accxes Indexer on page B-1 for more information.

File types

Accxes Indexer is written to work with most common file formats, such as: TIFF, JPEG, BMP, PDF, and
HPGL. These files may be 1-bit monochrome, 8-bit gray scale or 24-bit color. For more detail, see
Appendix C on page C-1.

Note

The makeup of a file with an apparently standard file extension can vary a great deal. Not all
types will work with Accxes Indexer. Sample files should be tested as required.

As part of the indexing process, Accxes Indexer also supports post-processing options that can be
configured to save scanned images as other file types that may not be supported natively by Accxes
Indexer. Additional software is required to make this work. Information on configuring post-processing
options can be found in the section entitled: Post-Processing Tab.

If a previously configured post-processing option is required, use the Type drop down field to select the
option before you start indexing scanned images.
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Customizing Accxes Indexer

Overview

Accxes Indexer is a fully customer configurable application, designed to integrate into many
workflows.

From the Settings menu, all the available selections can be saved to different profiles. This allows users
to select from a list of profiles, which are associated with various indexing configurations. This provides
users with the ability to quickly select, custom indexing.

Access to the Settings menu can be password protected by selecting [Change Password] and entering
the details in the Change Password dialogue box. To remove a password, select [Change Password] in

the Settings menu, and select [OK] without entering a password. The remainder of this guide describes
how to use all the Accxes Indexer settings.

Settings profiles

Accxes Indexer uses a system known as Settings Profiles which allow various indexing configurations to
be imported, exported, and saved. These configurations meet various requirements, such as different
naming conventions, document types, source of the images, etc. Users may easily swap profiles using
the profiles drop down menu in the Accxes Indexer indexing window. To stop indexing at any time,
users can select the [None] option on the profile drop down menu or close the indexing main window.

Note

The current indexing session will be suspended if the settings window is opened. Re-opening the
profile will continue with the document that was previously open, unless it was removed at the
source.

Profiles can be created by typing a new name in the profile field at the bottom of the settings window,
and select [Save]. This saves a copy of the current settings as a new profile. To delete a profile, select
the profile using the drop down box, and select [Delete].

The name of a settings profile may be passed to Accxes Indexer on the command line. This enables a
desktop shortcut, or third-party application to launch Accxes Indexer directly into a chosen
configuration. If a settings profile is passed on the command line or via a shortcut, the Profile and
Settings menus will not be available in Accxes Indexer. However, this does not apply to either the
Import or Export options.
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Launching Accxes Indexer into a profile

To create a shortcut to a profile, perform the following steps:

40. On the computer’s desktop, create a shortcut to Indexer.exe.

41. Right click on the shortcut and select Properties.

42. Press the space bar on the keyboard to add a space at the end of the target.

43. Enter the desired profile name for the Profile you want to load; for example profilename.
44, Select [OK] to save.

45. Double-click the newly created shortcut and the profile is loaded.

Launching Accxes Indexer into a profile from the command line

Perform the following:

1. From the command line (DOS), enter C:\Program Files\Xerox\Wide Format\Xerox Wide Format
FreeFlow Accxes Indexer\Indexer.exe profilename, or

2. Change the directory to where the Accxes Indexer software is installed
3. Enter Indexer.exe profilename

Importing/exporting Accxes Indexer settings

Settings can be imported (loaded) or exported (saved). There are two types of settings: one with a .qit
file extension and one with a .qgis file extension. Settings with a .qit extension will be merged with any
existing settings when loaded. Settings with a .gis extension will replace or overwrite any existing
settings when loaded. Export or save files with either a .qit or .qgis file extension.

A profile which is accidentally deleted can be easily restored if, prior to deletion, that profile was
previously exported or saved prior. To restore the profile, simply import the saved settings.

Note

Importing the saved settings will overwrite any new profiles that were created.

Shared profiles

By default profiles are only available to the Windows user who defines them. Administrative users have
the option to designate profiles as shared by using the Shared check box beside the profile name.
Shared profiles are available to all users on a workstation, but they can only be changed or deleted by
Administrators.

When Client Accxes Indexer applications are licensed (see licensing section) any shared profiles on the
Server application will also be available on the Clients.
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Source tab

Overview

The Source tab is used to configure how and from where Accxes Indexer obtains images. The source
location may be a directory containing images that could have come from another scanner or directly
from the Xerox Wide Format Scan System via the scanner (Accxes) controller.

Folder

When Folder is selected, the Browse button can be used to select a directory that contains images for
indexing. This could be used for legacy files that may have been scanned previously or from another
scanning device.

For example, this setting could be used when a number of scanned images have been deposited into a
directory using the Accxes Client Tools for indexing later.

The rest of the Accxes Indexer options for indexing from a folder can be configured in the same way as

when receiving images directly from a Xerox Wide Format Scan System.

Accxes

When Accxes is selected, Accxes Indexer will automatically obtain scanned images over the network,
directly from the Xerox Wide Format Scan System. In the address field, the TCP/IP address of the
Accxes controller should be entered.

For example: 10.1.5.21

In the Directory field, the name or number you type must correspond with the exact name or number
that is used at the scanner when Scan Mode is selected. This field is case sensitive in Accxes Indexer
and at the Xerox Wide Format Scan System.

For further information on how this corresponds to the Xerox Wide Format Scan System, refer to

Appendix A on page A-1.

Enable polling

The field specifying the time for polling, determines the interval between checking for images. The
value can be set between 2 and 45 seconds (Default is 5). A low number means that a scanned image
appears almost instantly after it is scanned.
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Auto Accept

Auto Accept mode allows you to automatically view documents as you scan them and index each one
by simply inserting the next.

If Auto Accept mode is switched on, Accxes Indexer automatically accepts the current scan as soon as
it sees a new scan arrive. This feature only works if all the index fields are populated, and should
therefore be used with either multi-page mode (see Advanced Tab), an auto incrementing field (see
Index Fields Tab), or the @a filter option (see Index Fields Tab)

With one of these options enabled you may batch scan and index saved documents without leaving
the scanner.

Each scan will appear on screen. A visual check of the quality is provided in the main indexing window
before continuing with the next scan. If the quality is not acceptable you can simply reject that scan,
adjust the scan parameters and rescan the document before continuing.

In multi-page mode you must select the [New] button on the Accxes Indexer indexing window when
you start the first page of a new multi-page document.

With an auto incrementing field, files will be named with an increasing number at the end of that field,
thus automatically generating new file names.

Documents scanned in Auto Accept mode with an auto incrementing field can be renamed at a later
date. To do this, Accxes Indexer can be set-up with a profile that uses a source folder rather than the
Accxes controller, and then this folder becomes the location of the saved scanned files.

All settings must be saved to a Profile or they will be discarded.
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Destination tab

Overview

The Destination tab is used to configure where the indexed images will be saved and where directory
structures created or selected during indexing will reside. A different destination can be selected for
accepted and rejected images.

Destination folder

The Destination folder is the root folder for all accepted images. Either type the path or use the browse
button to select this folder. When searching for an appropriate folder, the option to create one is also
provided.

Note

Any folders selected under the Index Fields tab will be created as a directory tree within the
Destination folder.

Save on reject

If this box is checked, then rejected scans will be saved to the Reject folder. Otherwise, rejected images
will be deleted when the reject button is selected.

If Save On Reject is active then scans must be given a valid name for identification, before they can be

rejected and moved to the Reject folder.

Reject folder

If required, a folder can be selected to store all the rejected scans for later resolution. This folder cannot
be selected unless the Save On Reject check box is selected.

The Reject Folder can be created or selected in the same manner as the Destination folder above.

When an image is rejected, a reason for the rejection can be selected as specified in the Reasons tab
detailed in the section entitled: Reason Tab.

All settings must be saved to a Profile or they will be discarded.
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Initial view tab

Overview

The Initial View tab is used to determine the area of the image that is initially viewed (by default) in
the Accxes Indexer main window. The accuracy of this selection will depend upon the images being
indexed.

When indexing images, the fastest way is to have the title block viewed automatically. In order to
accomplish this with scanned images, the document must first be scanned in the appropriate
orientation to match the settings in Accxes Indexer. (See below and Appendix A on page A-1 for more
information on scanning the document.). The most typical selections are explained in this chapter.

Note

The initial view will always be the whole drawing if the image was scanned in preview mode. See
Appendix B on page B-1 for more details on preview mode.

When indexing image files from other sources, such as plot files, the area viewed will be dependent
upon the way the image file was created. Some drawing packages will produce a file upside down.
Experimenting with the package creating the file can help to produce consistent results for indexing. In
any event, Accxes Indexer allows the image to be rotated to view the desired orientation.

Initial view

The choice for the default initial view of the scanned image is one of the following: Whole Drawing, Top
Left, Top Right, Bottom Left, or Bottom Right.

The best setting for the Initial View is Bottom Right. This corresponds to the position of the title block
for most scanned images as detailed overview and in Appendix A on page A-1.

This setting is also best used for other image formats, but is dependent upon the way they were
created. Accxes Indexer allows images to be rotated to view the desired orientation. Experimenting
with the package creating the file can help to produce consistent results for indexing.

Zoom factor

The Zoom Factor is only used when viewing one corner of the image in order to aid indexing important
information from the title block. Zoom Factor cannot be set when Whole Drawing is selected.

The Zoom Factor determines the magnification of the title block in the main Accxes Indexer indexing
window. There is a small sample icon in the settings menu to show the effect of the Zoom Factor.

The Zoom Factor can be set between 1 and 20. A Zoom Factor of 4 to 5 will work best for viewing most
documents. This is dependant upon the way the file was created as previously mentioned.
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Scanning in the appropriate orientation

When considering standard ISO sizes, documents of A1/Arch D size or smaller can be fed through the
Xerox Wide Format Scan System in the landscape orientation, (or long edge first — LEF); refer to the
following illustration.

]| LEF |1l t

=
Title BlOCK  —_—_—- Feed Direction

By feeding the document into the scanner Long Edge Feed (LEF) and with the title block trailing (in
other words, the last edge to go into the scanner), the image is in the correct orientation to match the
Accxes Indexer Initial View setting of Bottom Right and aids fast indexing.

Documents larger than A1/Arch D, such as AO size documents have to be fed into the scanner short
edge first (SEF). Such images can be rotated in Accxes Indexer in order to view the title block.

All settings must be saved to a Profile or they will be discarded.

Index fields tab

Overview

The Index Fields Tab is used to customize the way in which indexing will be applied to image files. Up
to 10 fields can be applied. These fields can be used to rename the scanned images with reference to
drawing numbers, revision, etc. Fields can be set to create/select directory structures so that scanned
images can be automatically indexed into directories that reference specific job names or project
numbers, etc.

Fields used for indexing can have information inserted automatically such as the date or time. Fields
can also be configured to only accept a predefined pattern of numbers or letters.

An up/down arrow is used to select the number of indexing fields required.

Name

Each field requires a name. This name will appear above the indexing field in the main Accxes Indexer
indexing window. This name will also be passed to any Post-Processor being used (see the Post-
Processor Tab).
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Separator

The separator character determines whether a sub-directory is to be created or a specific naming
convention is to be used in the indexed filename.

Examples of Separators are as follows:

Backslash (\): This means that a directory will be selected and/or created and then named according
to what the user types in the field when using the Accxes Indexer indexing window.

When creating a directory as an indexing field, at least one other field must be configured to specify
the name of the image file. The user will be asked if they wish to create the directory if it does not exist.
(If the Style field is set to List Only or List Once the user will not be prompted.)

All directories are created within the Accepted Directory; this is previously setup in the Destination Tab.
The drop down list of a directory field automatically has existing directories added to it. Allowable
values for a directory field may be controlled by either creating directories in advance or using the Filter
setting to specify a list, and setting the Style field to List Only.

Underscore (_): This will separate the fields to create a filename as follows:
e drawingno_revision.tif or
e jobname_drawingno_revision.tif

Hyphen (-): This separates the fields to create a filename as follows:
e drawingno-revision.tif or
e jobname-drawingno-revision.tif

Any legal character for use in a file name can be used as a separator, or the field can be left blank if
required. For example the forward slash (/) is NOT a legal character.

During indexing the user will automatically be taken to the next field (if one exists) if they type the
separator character for the current field as well as using the [Tab] or [Enter] key.

Filenames incorporating underscores and hyphens can be used to separate important information such
as drawing number and revision. This produces a format that can be used to import the image
information as well as the image file itself into some Document Management Systems.
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Auto Value

This option is aimed at advanced users and experimentation to get the desired results is required.

Auto Value is used to automatically insert information into the indexing field, such as the date for
example. When selecting Yes in the Auto Value drop down, the Filter box is used to determine the
nature of the Auto Value.

The following can be used as Auto Values:
%d = Date
%t =Time
% m = Workstation Name
% u = Current Username
<filename> = Read the first line of file filename
<% envVar> = Read the first line of filename in environment variable envVar
[envVar] = environment variable envVar

$? = If the source is a directory, and a file exists with the same name as the current image, but
with the extension .CSV, read the ?th field from the first line of the file.

The file fields in the file should be separated using commas. The first field is $0 and the last is $9

Other characters appear as entered. To enter symbol characters (such as the %, @, *, 1, [, 1, <, >, or $),
prefix them with a percentage symbol (% ); for example % $.

Examples:
1. Toinsert the date into the filename of the image:
Type Date in the Name box.
Select Yes in the Auto Value drop down.
In the Filter box, type: %d
2. To insert username and machine name in the format
username@machinename
Type User ID in the Name box.
Select Yes in the Auto Value drop down.
If the Filter box type: %u% @ % m

Refer to the following sections for more information: Using all or part of the original file name on
page 2-20 and Using the filter box to exclude a field from the file name on page 2-22.

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy  2-19
User Guide



Accxes Indexer

Using all or part of the original file name

When indexing files from a folder, it is possible to use Auto Value fields to include all or part of the
original filename. This is achieved by setting the desired field(s) to Type Auto Value and entering the
following in the Filter box:

#<Separator><Terminator><Separator Count>

Where:
<Separator> Is a character that separates parts of the filename.

<Terminator> Is a character that marks then end of the text. A terminator of ! will use everything
to the end of the filename.

<Separator Count> Is a number from 0 to 9, identifying which occurrence of <Separator> to start
at.

Example: Original Filename: Document-1-a.TIF

Filter Result

#110 Document-1-a.TIF
#-1 1-a

#--1 1

#-.2 a

#-.0 Document-1-a
#--0 Document
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Filter

This option is aimed at advanced users and experimentation to get the desired results is required.

If the Auto Value drop down is set to No, the Filter box can be used to define patterns that index fields
must follow.

The following can be used as Filters:

[abcdefABC...] Characters used in the indexing field, must
match any ONE of the characters in the brackets.

This match is case sensitive.

[A-Za-Z] A range may be used, so:
[A-Za-z] indexing field must match a letter of the
alphabet

[1-5] and

[1-5] indexing field must match a number
between 1 and 5.

HHHH This will match numbers. One # symbol per digit.

2727? Matches any character. One ? symbol per
character.

* Matches any number of characters.

(Item 1 Item 2...) Includes entries Item 1, Item 2 in the drop

down list for the field.

<filename> Each line in filename is added to the drop
down list for the field

Any other characters entered in a filter will match themselves only. The above patterns may be joined
to create more complex patterns.

Examples:
1. To force a revision field to be a single, uppercase character, enter:
[A-Z]
2. Toforce arevision field to be a single, uppercase character, or a number, enter:
[A-Z0-9]
3. To force a drawing number to follow the format ‘QA1234_5678x’ where x is any letter and the
digits can be any number, enter:
QAHHHHE-HHEFTA-Z a-Z]
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Allowing optional/empty fields

By default, Accxes Indexer requires that all fields have a value entered into them. Sometimes it is
desirable to allow a field to be optional.

The following option in the filter field allows this.

Caret symbol (*): Enter this character somewhere in the filter box to allow the field value to be
empty.

Using the filter box to exclude a field from the file name

Accxes Indexer will normally use all indexing fields to create directories and/or the filename. However,
there may be circumstances where an indexing field is required for another use. For example a
description field that you may just want to pass to a post processor, or record in the log file.

Exclamation point symbol (1): To prevent Accxes Indexer from using a field in the filename.

The exclamation mark (!) character must prefix the Filter box. If the Filter box is not being used then
enter a single ! symbol in the Filter box. Remember that at least one index field is required for the
filename.

Using the filter box to control behavior for existing files

By default, if Accxes Indexer tries to save to an existing file name, it asks whether the file should be
overwritten. This behavior can be changed by including the following values for any of the filter boxes:

@a - Automatically generates a new unique name. This will normally involve appending a number to
the end of the name; for example: scan_0.tif

@p - Prompts the user for the desired action (default)
@o - Overwrites files without asking.
@f - Fail, do not allow overwriting of files.

The @a option is particularly useful with AutoAccept mode, allowing fully automatic filename
generation. This is achieved by setting all fields to Auto Value =YES, entering any desired prefix in the
filter box, and include @a in one of the filter boxes.

Replacement character

A replacement character can be specified to automatically replace any illegal characters entered, such
as a forward slash, during the indexing process.

The default replacement character is an underscore. This will be used to replace any illegal characters
used in the filename. If this field is left blank, a warning message is displayed when illegal characters
are used.
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Style

The options for Style can be set to Keep, Forget, Increment, Clear, List Only and List Once. The following
explains the use of each selection:

Keep - The field value will be retained for every new image, allowing the user to overtype it if
required. Each value used will be added to the drop down list.

Forget - The field will be cleared for every new image, and the previous value will not be added to
the drop down list.

Increment - The last number in the field will be incrementally adjusted as required. For example If
the value 1234 or ABC1 is entered, the next image will automatically have the value increased to
1235 or ABC2.

Clear - The field will be cleared for every new image, but the previous value will be added to the
drop down list.

List Only - Only items in the drop down list will be accepted. Use this option to limit the available
values for a field, or force the use of existing directories.

List Once - Only items in the drop down list will be accepted, and once used they will be removed
from the list. This option is useful if the list is sourced from a file (refer to Filter on page 2-21), and
the file contains a list of drawing numbers that are going to be scanned. As each drawing is picked
from the list it will be removed so that it cannot be overwritten.

Example: To set-up indexing to archive a number of scanned images for specific projects, perform the

following:

1. The first Name field should be followed by a backlash (\) as the separator value. This will create
directories for each project. Set the Style field to Keep.

2. The second Name field will be used for the filename. Set the Style field to Forget.

3. When the first image for a specific project is indexed, the project name can be entered and you
will be prompted whether to accept the creation of the directory during indexing.

4. Tab to the next field to enter the filename. All subsequent images will be indexed to the same
folder. To save time, the cursor will automatically be in the next indexing field used to enter the
filename.

5. When an image needs to be saved to a different directory, select the mouse in the first field and

enter the new name or select the name of a folder previously created from the list.

All settings must be saved to a Profile or they will be discarded.
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Post-processing tab

Overview

The Post-Processing tab is used to configure additional processing options to images when being
indexed. A maximum of five (5) post-processors can be specified.

Configured post-processors are displayed in the Type drop down list of the Accxes Indexer indexing
window. Configuring post-processors removes the default type from the list, and instead the first Post-
Processor becomes the default.

Accxes Indexer includes five internal post processors. The can be used to automatically convert
documents to one of the following formats:

e PDF: PDF v1.6 — Supports multi-page documents.
e  Postscript: PS Level 3

e  TIFF: TIFF 6 — Supports multi-page documents

e JPEG: JPEG (Color and gray scale Only)

e  Original: Retain the documents original format.

Accxes Indexer also allows external post processors to be defined; for example importing a document
into a Document Management system.

The rest of this chapter provides information of configuring external post processors.
Note

Xerox does not guarantee the success of any postprocessing options, neither are any specific post-
processing options supported. All post-processing options depend upon third party software and
are the responsibility of the system administrator.

Name

This is the name displayed in the Type drop-down list. This name should meaningful to the Accxes
Indexer users in order to clearly identify the nature of the post-processor.

Command

This is the full path and filename of the post-processor command. This would normally be an
executable or batch file. A browse button is available to the right of this box.

Options

Any command line options required. See the section overleaf (Post-Processor Environment Variables)
for examples.
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Extension

This is the extension of files created. For example PDF for a PDF converter. Accxes Indexer will
automatically add a leading period if one is not entered. Leaving extension empty or entering just a
period (full stop) in this box causes Accxes Indexer to use the extension of the source image.

Execution

If configured, the post-processor command is launched whenever an image is accepted. If multi-page
support is enabled the post-processor is only launched when a new document is created, the profile is
changed, or Accxes Indexer is closed. Post processors are not launched for rejected images.

When a post-processor is in use, Accxes Indexer does not save images to their destination file name,
instead files are saved with a temporary file name, and the name of the temporary file (source file) and
destination file are passed to the post-processor. The destination file will exist as an empty file, and the
post-processor must overwrite it.

Post-processor environment variables

The following information is passed to the application in the form of Environment variables.
SRCFILE - The 8.3 format path and filename of the source image.

SRCFILENAME- The long source filename, excluding path and extension.

SRCFILEEXT - The extension of the source file (eg. TIF)

SRCFILEPATH - The long directory name of the source file.

DESTFILE - The 8.3 format path and filename of the destination image. This is created from the
Accxes Indexer naming fields and settings.

DESTFILENAME - The long destination filename, excluding path and extension.
DESTFILEEXT - The extension of the destination file (eg. TIF)

DESTFILEPATH - The long directory name of the destination file.

PROFILE - The name of the Accxes Indexer settings profile in use.

FIELDQTY - The number of index fields in use.

FIELDNAME_n - The name of the nth index field. (n the number 1 to 10)
FIELDVAL n - The contents of the nth index field. (n the number 1 to 10)

A knowledge of the use of environment variables is required to create external post processors. As the
following section shows, the simplest way of implementing a post processor is often with a Batch file.

There are many good, free, sources of information on the use of environment variables available on the
internet which may be consulted.
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Example uses of post-processors

Two sample external post processors are included with Accxes Indexer. These may be found in the
Support folder in the installation location. On a standard install this is normally:

C:\Program Files\Xerox\DocuWide Qseries\DocuWide Accxes Indexer\Support

The following sections provide further information on the samples.

Exporting documents using CSV files

Most document management packages have a method of importing documents and their details. A
popular method for this is using Comma Separated Value files, to provide details of a document
filename and its attributes.

This example creates a CSV file of index information with each document in the destination folder.

The post-processing fields must be configured to use MakeCSV.BAT.
e Inthe Name field, type:
e (CSV

e Inthe Command field, use the browse button to locate MakeCSV.BAT in the Support folder as
detailed above.

e Leave the Options field blank.

e Leave the Extension field blank.

In the Accxes Indexer indexing window, the Type drop down list will now contain an entry called CSV. If
this is the first post-processor entry, it will automatically be selected. When a document is accepted, a
CSV file of the same name will be created in the destination directory. This can be opened with an
application such as MS Excel to examine the results.

The MakeCSV.BAT file can be viewed and modified with a text editor such as Notepad. The file
includes comments to assist in changing its operation.
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Email the document with Microsoft® Outlook®

For security reasons many Email applications, including Microsoft Outlook have reduced their MAPI
capability for attachments. This can prevent the email icon in Accxes Indexer being used to send an
email.

An alternative method is to create a post processor to send the email. Most Email applications support
command line options for this. This example shows how it may be achieved with Microsoft Outlook
2000 or 2003.

The post-processing fields must be configured to use OutlookEmail.BAT.
e Inthe Name field, type:
Email
e Inthe Command field, use the browse button to locate
OutlookEmail.BAT in the Support folder as detailed above.
e Leave the Options field blank.
e Inthe extension field enter PDF, to all files are sent in PDF format.

In the Accxes Indexer indexing window, the Type drop down list will now contain an entry called Email.
If this is the first post-processor entry, it will automatically be selected.

For this post processor to work correctly, Field 6 should be configured with the name ‘Email Address’
with a ! character at the beginning of the filter to prevent the email address being used in the filename.

When a document is accepted, Microsoft Outlook is opened with a new Email message, to the address
entered in Field 6 with a PDF of the viewed document attached.

The OutlookEmail.BAT file can be viewed and modified with a text editor such as Notepad. The file
includes comments to assist in changing its operation. It may be necessary to edit the file and change
the path of the Outlook.exe executable file.

This is example may also be used as a starting point for configuring other Email clients for use with
Accxes Indexer.
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Reasons tab

Overview

The Reasons tab is used to create up to 24 reasons that can be selected and entered in the log file,
when rejecting scanned images during indexing.

To reject a scanned image, the reject button is selected in the Accxes Indexer main indexing window.
Providing at least one reason is configured in the Reasons tab, a drop down box appears to prompt the
user to select a reason for rejecting the scanned image. The user can also enter a different reason at
that point.

The image will be sent to the Reject folder, which is set-up as specified in the section entitled:
Destination Tab. A text log file lists the name of the scanned image together with the reason for
rejection. The section entitled: Advanced Tab details how to set-up the log file.

How to set-up reject reasons

Select the Settings menu in the Accxes Indexer indexing window. Select the Reasons tab and use the
drop down field to select the number of rejection reasons. Type the required reason into each field that
appears.

All settings must be saved to a Profile or they will be discarded.
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Advanced tab

Overview

The Advanced tab is used to configure the following:

e  Third-party Raster Editor (refer to Appendix E for information on how to configure third-party
applications as an editor)

e Xerox Wide Format Accxes-based printer for check-prints; this is not the same as setting up
automatic check-prints as detailed in the section entitled: Post-Processing Tab

e  Multipage Support
e Logfile

Enable editor

Accxes Indexer can be set to use some third-party raster editors. The Edit button in the Accxes Indexer
indexing window will only be present if an editor has been selected.

Place the cursor in the Enable Editor check box and in the Path field, browse to the executable file that
Windows uses to start the raster editor.

When viewing a scanned image in the Accxes Indexer indexing window, the user can select the Edit
button to open the image in the raster editor. Changes can be made to the image file and be saved.
Closing the raster editor will view the image back in the Accxes Indexer indexing window.

Note

The edit button will not be available if the image was scanned in preview mode. See Appendix B
on page B-1 for more details on preview mode.

Enable printer

Note

Checkprints are currently only supported on Accxes-based Xerox Wide Format printers.

Accxes Indexer can be configured to request a print of an image currently viewed during the indexing
process. This is useful to clarify any uncertainty of scanned image quality before the image is accepted.

Check the Enable Printer check box and in the Path field edit the following text:
lpr -SAccXESAddr -Praw

Change Accxes Address to the TCP/IP address of the Accxes-based printer so that the line of text reads
as shown in the following example:

lpr-S10.1.5.21 -Praw
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Multi-page support

Accxes Indexer can be set-up to create multi-page TIFF documents from individual scanned images.

Check the Multi-Page Support check box and save all the settings to a profile that identifies the Multi-
page selection.

When creating multi-page documents during indexing, a new field appears in the main indexing
window. The value of this field increases as each image is indexed into the final multi-page document.

When the first image is indexed, another button will appear in the main indexing window called [New].
This allows the user to determine when to begin a new multi-page document. When the [New] button
is checked, the page number field will revert to 1 and the [New] button will disappear until the next
image has been indexed.

If post-processors are enabled they will only be executed when the new button is checked.

When using multi-page mode, closing Accxes Indexer, entering the settings menu, or changing profile,
will also have the effect of checking the new button.

Enable reporting

Accxes Indexer can be set-up to create a log file to report the path and filename details of all scanned
images. Rejected images will also contain the reason for rejection in the log file.

The log file records the data in a comma delimited format which may be processed by third-party
programs such as Microsoft Excel and can be used to import the data, as well as the image, into some
document management systems.

Check in the Enable Reporting check box and in the Path field, browse to the directory in which you
wish to create the log file.

In the Select a Report File window, type a name such as QILog.csv in the filename field and select
[Open].

PDF/A-1b

This feature provides for the long-term preservation of the visual appearance of electronic documents
including scanned documents. On the Advanced tab in Accxes Indexer Settings, PDF/A-1b enablement
is available. Once enabled all PDF files will be generated as PDF/A-1b compliant electronic document.
One major benefit of this is when indexing, if a PDF file has metadata entries matching index field
names, these fields are automatically populated.
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Uninstalling the Accxes Indexer

Note

Uninstalling Accxes Indexer will leave the following:

e Indexed image files.

e The directories created for containing the indexed images.

e Thelogfile

Tip

The following procedures does NOT work for Windows 7 or Windows Vista; refer to X and X for
more information.

To uninstall the Accxes Indexer:

1.
2.

Select Start > Settings > Control Panel > Add/Remove Programs.

In the software list, select Xerox Wide Format FreeFlow Accxes Indexer. Check the [Add/Remove]
button.

The Accxes Indexer removal program will come open. Check [OK] to confirm.

Uninstalling Accxes Indexer on a Windows 7 computer

Perform the following steps:

1.
2.

Select Control Panel > Programs.

In the software list, select Xerox Wide Format FreeFlow Accxes Indexer. Check the [Add/Remove]
button.

The Accxes Indexer removal program will come open. Check [OK] to confirm.

Uninstalling Accxes Indexer on a Windows Vista computer

Select Control Panel > Remove Programs.

In the software list, select Xerox Wide Format FreeFlow Accxes Indexer. Check the [Add/Remove]
button.

The Accxes Indexer removal program will come open. Check [OK] to confirm.
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Escalations

To aid problem investigators, Accxes Indexer logging can be enabled. Once enabled, the information is
logged in a text file. When escalating an issue or problem, include as much information as possible in
the report, such as:

A description of the problem and how to reproduce it
Any settings export file

Any sample documents which identify the issue

Any log file

Enable logging

To enable logging, perform the following:

1.

i wN

On the computer’s desktop, create a shortcut to Indexer.exe.

Right click the shortcut and select Properties.

Using the space key on the computer’s keyboard, add a space at the end of the target.
Using the keyboard, enter --XSHOWLOG c:\qindexerlog.log

Select OK to save.

Note

Each time Accxes Indexer is launched from the shortcut, and while Accxes Indexer is running, the
logging information is captured using this shortcut. The log file can be deleted and re-created at
any time.

Disable logging

To disable logging, perform the following:

1.
2.
3.

2-32

Right click on the shortcut to Indexer and select Properties.
Remove from --XSHOWLOG c:\qindexerlog.log the target.
Select OK to save.
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Accxes Copy overview

Accxes Copy allows the user to:

View the currently selected image (Viewer feature)

Show thumbnails of a scanned document (Preview Pane)

Displays whether or not a scanner is connected (Scanner Status)

Displays the size of the currently selected document (Document Size feature)
Selects an area of the image that can be printed (Area of Interest feature)
Check what image data has been captured (Low Resolution Zoom feature)
Sets the Printer, Size, Scale, Quality, & Copies (Low Resolution Zoom feature)
Prints the currently scanned/viewed image

Scan to PDF file with PDF/A-1b compliance

Note

You will need Adobe® Acrobat® Reader™ to view PDF® documents. Download a free copy from
the Adobe Web Site http://get.adobe.com/reader/.
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Accxes Copy quick set up

After the Accxes Copy application is licensed, Accxes Copy automatically launches the configuration
tools. This chapter provides step-by-step instructions for quickly setting up and using Accxes Copy,
including the configuration of Xerox and non-Xerox printers.

Managing Xerox 7142 printers
Note

If Accxes Copy is being used with a Xerox 7142 printer, perform the activities in this section. For
ALL other printers, refer to Managing non-Xerox printers on page 3-7.

Once licensed, the Accxes Copy application launches these options: Manage Printers and Add Printer.

Manage Printers

Mame Address

| Model | Wersion

fdd Printer

Marne: Tupe:

[s0udF 7142 eron 7142 -]

Printer:

[192.168.1.42 |

Properties
k. | Cancel |

Ok Lancel

Note

The Manage Printers and Add Printer options is also accessed from the Options menu from the
Accxes Copy User Interface.

To add the Xerox 7142 printer, perform the following:

Click Options > Manage Printers > New.

2. Enter a name for the 7142 printer such as XWF 7142,

3. Inthe Type pull-down field, select Xerox 7142.

4. Inthe Printer field, enter the TCP/IP address of the Xerox 7142.

—_—
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5. Select [Properties].

Printer Properties

Print Modes:

Bemove

Copy

Edit

LCancel

ol

a. Accxes Copy automatically creates the print driver and three default print modes.

b. The Printer Properties window displays the three default print modes listed as Best, Draft,
and Normal.

e  These three print modes match the names of the print quality modes that are available for
use when making copies in the main Accxes Copy window.

e These modes can be edited, removed, and added depending upon customer requirements.
6. Continue to Print Mode Configurations on page 3-3.

Print Mode Configurations

Best

7. Select Best and select [Edit] to open the Xerox 7142 Printer Preferences.
o Check/edit the following selections within the Xerox 7142 Printer Preferences:
a. Inthe Basic tab
e  Plot Direction - Landscape
e Media Type - Coated Media
b. Select [Advanced]
e  Output Quality Output Mode - 720dpi
e  Output Quality Data Resolution - 540dpi
e Jet Direction - Bi-Direction
e Pass- 4 Pass
e Effect - Super Fine & Wave
e  Color Management - Handled by Driver enabled
e Variable Dot - Enabled
e Dither - Error Diffusion (Lines) enabled
¢. Select [OK] to close the Advanced Printer Properties.

Select [OK] to close the Printer Preferences window and return to the Accxes Copy Printer
Properties window.

8. Continue to the Draft section.
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Draft

9. Select Draft and select [Edit] to open the Xerox 7142 Printer Preferences.
10. Make the following selections within the Xerox 7142 Printer Preferences:
a. Inthe Basictab
e  Plot Direction - Landscape
e Media Type - Plain Paper
b. Select [Advanced]
e  Output Quality Output Mode - HS360dpi
e  Output Quality Data Resolution - 180dpi
e Jet Direction - Bi-Direction
e Pass- 1 Pass
e  Effect- None 1
e  Color Management - Handled by Driver enabled
e Variable Dot - Enable
e  Dither - Error Diffusion (Lines) enabled
11. Select [OK] to close the Advanced Printer Properties.

12. Select [OK] to close the Printer Preferences window and return to the Accxes Copy Printer
Properties window.

13. Continue to the Normal section.

Normal

14. Select Normal and select [Edit] to open the Xerox 7142 Printer Preferences.
15. Make the following selections within the Xerox 7142 Printer Preferences:
a. Inthe Basictab
e  Plot Direction - Landscape
e Media Type - Coated Media
b. Select [Advanced]
e  Output Quality Output Mode - 360dpi
e  Output Quality Data Resolution - 360dpi
e Jet Direction - Bi-Direction
e  Pass- 2 Pass
e  Effect- Fine & Wave 1
e  Color Management - Handled by Driver enabled
e Variable Dot - Enable
e  Dither - Error Diffusion (Lines) enabled
16. Select [OK] to close the Advanced Printer Properties.
17. Select [OK] to close the Printer Preferences window.
18. Select [OK] to close the Printer Properties window.
19. Select [OK] to close the Add Printer dialogue to return to the Manage Printers window.
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From the Manage Printers window and with the new printer created and highlighted, the default
roll size is visible in the Available Page Sizes field: Roll_AO.

Note

For the purposes of this installation, it is recommended that you use a good quality coated CAD
media or better and A0/36 in. (841mm) wide. If a good quality media is not available, the best
possible copy quality may not be achieved.

If the currently loaded media roll is not an A0/36 in. roll complete the following activities:

a. Alongside the Available Page Sizes field, select [Add] to open the list of possible page sizes.
b. Select aroll size that is installed in the printer and select [Ok].

Note

It is imperative that you identify the exact roll size loaded in the printer to ensure correct
orientation of printing.

20. Select [OK} to close the Manage Printers window

21.

Continue to Scanner settings on page 3-6.

Adding PDF as a printer type

PDF as a printer type allows the user to scan-to-file with full support of color controls and scaling. All
files are PDF/A-1b compliant.

Add Printer

Hame: Type:

|Copy2PDF \FOF =]
Erinter:

|CATEMPYPDF-Copy2File

. | LCancel |

To create/setup a PDF printer type, perform the following:

1.
2.
3.

Click on Options > Managed Printers > New (button).
Select PDF from the Type drop-down box.
Enter an arbitrary name in the Name field.

This name will become selectable from the Accxes Copy main User Interface (UI) Printer drop-
down box.

Enter an existing directory name in the Printer field.

This will be the name of the directory where scanned images will be stored. The Quality field on
the Accxes Copy main UI will show PDF. When an image is scanned and displayed in the viewer

and the Copy (green) button is pressed, the file will be stored as a PDF/A-1b compliant file in the
directory that was specified.
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Scanner settings

Once a printer is configured, you can set-up the various settings that work with the Xerox color scanner.
This can be done at the current time or at a later date.

Note

The scanner Settings window is also accessed from the Options > Settings menu on the Accxes
Copy User Interface.

Scanner:
Address:

[192 168.1.201
I ailbo:
|GCopy

Size Ranges:

M50
O amsl
O&RcH
OFal

[rits:

mm 57

1] | LCancel |

1. Enter the TCP/IP address of the Accxes controller that is connected to the scan system from which
the scanned images are obtained.

2. Enter the following name of the mailbox/directory: Accxes Copy.
Note

This name is case sensitive and must match exactly the same mailbox/directory name used at the
scanner.

3. Uncheck the sizes you do NOT require.
Do NOT uncheck any sizes that will be used with the system; typically these are only ISO sizes.

4. Select the desired Units (mm, cm, or inches).

5.  Select [OK] to close the scanner Settings window.

The Accxes Copy User Interface opens. Familiarize yourself with the Accxes Copy User Interface;
for detailed information, refer to User Interface (UI) overview on page 3-8.
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Managing non-Xerox printers

Once licensed, the Accxes Copy launches these options: Manage Printers and Add Printer.

Notes
e  Ensure that a suitable Windows print driver is installed on the computer that is hosting
Accxes Copy.
e  Ensure that a suitable print driver for the desired printer is installed on the computer that
is hosting Accxes Copy.

e Itis recommended that you use a good quality coated CAD media or better and
A0/36in. (841Tmm) wide or ArchD (24 x 36 in.) wide. If a good quality media is not
available, the best possible copy quality may not be achieved.

e  The Manage Printers and Add Printer windows can be accessed from the Options menu
on the Accxes Copy User Interface.

For further details, please refer to the documentation provided by the printer manufacturer.
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User Interface (UI) overview

The primary focus of Accxes Copy, in its default configuration, includes:

e  Copying technical documents, maps, line drawings, and color markups
e  Obtaining a white, black output with no loss of light colors

e  Obtaining an acceptable output result with the first scan

Refer to Appendix F, Accxes Copy image editing guidelines on page F-1 for more information.

After the printer and scanner settings have been configured, the application will launch as shown in the
image below (To aid clarification, this example also includes two images and the Sets Build option has
been enabled from the Options menu):

Accxes Copy Main User Interface: The following illustration is a representation of what a user may
see on the main menu

¥ Xerox FroeFlow Accxes Copy

d Thisisthe main

Fle Optioes  Templstes  Melp ) ¢
This is the [ry— —— view o
currently = _ — currently
selected ! e selected image
mose \{ e e 7
il _ L, |__] These are
-_.f [ selected
= mesarl, e Printer &
Seanreey, Mok Comevecil Sampled 555 72 « 118 S /Copy
isi > 4 - i z Controls
Th|s‘|s the This is visible - . - &y 3
PreV|.ew Pane only when used - | " C R T
and it to build sets. T —
displays the | i -
currently - - ] =
Z%c::r;rr\sgnts \ \Use these buttons to add

or remove documents from
the set

Use these buttons to add or
remove documents (removing
also deletes them from the scan
system)

e  While viewing an image, an Area of Interest (AOI) can be selected by using the left mouse button
to select and drag around the part of the image you wish to print. The AOT is deselected by a right
mouse click.

e  While viewing an image, holding down the right mouse button will provide a low resolution zoom
to check captured image data.

e Once the Accxes Copy application has started and you are familiar with the User Interface,
continue with the next task in the section entitled, “Color Calibration.”
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Auto Copy

The Auto Copy feature can be checked on the Options menu, which will cause scans to process
automatically with the current settings.

Saving a template with Auto Copy enabled causes Accxes Copy to check a mailbox with the same
name as the template, and automatically processes any files from the mailbox with the settings in the
template. Images will be deleted automatically after successful processing.

PDF printer type

This printer type allows the user to scan-to-file as a PDF. This printer type provides full support of color
controls and scaling. All PDF files are PDF/A-1b compliant.

Color calibration

Once Scanner connectivity and at least one suitable printer, together with the required print mode(s),
have all been established, the Color Calibration can be performed.

A WARNING: It is important to note that a calibration is only relevant for one printer, the currently
loaded media and the currently selected Accxes Copy print mode. Color calibration must be
performed for each available Accxes Copy print mode. (For example: Best, Normal and Draft for
the 7142) and any change in media type as backgrounds can vary. Once completed, the correct
calibration will automatically be available for the chosen Accxes Copy print mode. If no calibration
is available for a chosen print mode, the 'Use Calibration" menu item will be grayed out. While
calibrating, be sure to complete the current calibration process before making any changes to the
print mode.

e Before you start, ensure the printer is working correctly with no nozzles missing and loaded with a
suitable media stock identified and configured for use in the printer set-up as covered earlier in
this documentation. It is strongly recommended that the printer is loaded with a good quality
coated CAD media or better in order to demonstrate the capabilities of the software.

e Next, ensure the scanner is clean and working correctly.
e  From the Accxes Copy UI, ensure the printer is selected.

e  From the Accxes Copy UI, ensure the required print mode is selected from the 'Quality’ drop down
field in the lower right of the application. For the Xerox 7142, it is recommended that you start
with ‘Normal'.
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e  From the Accxes Copy UI, select Options > Print Calibration Chart. The calibration chart will print
as per shown in the example below:

A2 Calibration Cart

Notes

»  Forsmall format printers, the calibration chart will print an A4 size chart. For printers that
support A2 or larger, An A2 chart will print. A2 charts will provide slightly better accuracy
for the calibration.

e Once the calibration chart has been printed, it needs to be scanned back into the system
using the correct scan settings. The scanner settings will depend upon the Xerox scanner
model in use.

e  First refer to the section in this document entitled, 'Xerox Scanner - Recommended Scan
Settings’ and select the recommended scan settings for your scanner. Then return to the
next point in this section to complete the color calibration.

e Having chosen the relevant scan settings, ensure Accxes Copy is selected as the correct
mailbox/directory name and scan the calibration chart. The document can be fed into
the scanner either way around as the software will detect it accordingly.

3-10  Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy
User Guide



Accxes Copy

Following a short pause while the scan is transferred to Accxes Copy, a preview of the calibration image
will appear in the left preview pane of the Accxes Copy UL Select the preview so that it is visible in the
main Accxes Copy window.

From the Accxes Copy UI, select the Options menu.

In the Options menu, select 'Read Calibration Chart'. You will see a status bar appear as the
calibration is performed. The entire process may take approximately one to two minutes, or more
depending upon scan resolution and PC specification.

Note

As well as the color calibration, there are also color controls for further enhancement of the image.
These controls are disabled during the calibration process but are available for use together with
the calibration when making copies. Further detail of these controls is provided in the section in
this document entitled, ‘Accxes Copy - Test Configuration'.

Once the Calibration is finished, the 'Use Calibration’ option should be checked. See/Check this
from the Options menu in the Accxes Copy UI and view the effect on the calibration chart.

Note

If the scanned calibrated image in the Accxes Copy UI appears skewed or vastly different in
background color, a blurred image, etc. Or if the resultant copy exhibits poor quality, check the
calibration file to ensure the process has been completed successfully. In order to do this, perform
the following activities:

Leave the calibration process with the currently calibrated file in Accxes Copy unchanged.

On the PC hosting Accxes Copy go to Start > Run

Enter % temp % and select [OK].

In the window that opens, navigate to the following directory and locate the file called Last
Calibration End.jpg:

e  Xerox FreeFlow Accxes> Xerox FreeFlow Accxes Copy > Last Calibration End.jpg
Double click the file in order to view the image.

Check that the file views as shown in the example below.
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While viewing the large black border, check that the image is not skewed and check that all white
areas outside of the border have been cropped.

If the image does not view as shown in this example or if in any doubt, repeat the scan and ensure
the new scanned image is highlighted when selecting Read Calibration in the Options menu.

If the calibration sheet you are scanning was printed with nozzles missing, lines, skewed or
unwanted ink marks inside and/or outside the black border perform the following:

e  Ensure the printer is printing correctly and repeat the Print Calibration task

e Scanin the new printed image

e Highlight this new image

e Select Read Calibration from the Options menu to complete a new calibration.
Note

When performing a new ‘Read Calibration’, it will replace any existing calibration file for the
currently selected print mode.

With the first calibration completed, further print modes can be calibrated or recalibrated as follows:

3-12

Change the print mode to select one for which you need to perform a calibration or to select a
print mode that you wish to re-calibrate.

From the Accxes Copy UI, select Options > Print Calibration Chart. The calibration chart will print
using the selected print mode.

Using the correct scan settings, scan the new calibration print.

From the Accxes Copy UI Options menu, select 'Read Calibration Chart'. You will see a status bar
appear as the calibration is performed. The entire process may take approximately one to two
minutes, or more depending upon scan resolution and PC specification.

Repeat the process until all print modes have been printed and calibrated. For the Xerox 7142 this
will include Best, Normal and Draft.

The system is now ready to be tested as explained in the section in this document entitled,
"Accxes Copy - Test Configuration.”

Note

Color Calibration does not guarantee color accuracy and for some documents the best results may
be obtained by turning off the ‘Use Calibration’ option. Color accuracy/quality is directly affected
by the media type loaded in the printer, print mode options, scan mode options and Accxes Copy
color options. Experimentation will be required to obtain the best results.
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Recommended scan settings for Xerox scanners

This section details the scan settings recommended for each of the Xerox scanner models that can be
used with Accxes Copy.

Xerox Wide Format 6604 Solution™/6605 Solution™

When using the Xerox 6604/6605 with the color enabled scanner, the following settings are
recommended for both color calibration and copying:

At the scanner, configure a new Mailbox at the scanner with exactly the same name as that
entered in the Mailbox field of the Accxes Copy scan settings. In this set-up the Mailbox name is,
Accxes Copy. This name is case sensitive.

In the Scan to Mailbox tab, set the following options:
e Rendering: Color 24-bit

e  File Format: Jpeg

e  Original Document Type: Text/Photo

e  Compression: Best Image Quality

In the Image Quality tab, set the following options:

e Density: 0

e Contrast: 0

e  White Point: 0

In the Advanced Settings tab, set the following options:
e  Preview: Disabled

e  Resolution: 300dpi (Any higher can be used but will severely slow down calibration and
printing. It will also slow down the memory resources on the computer hosting Accxes Copy.)

Save all the above options to a template and call it Accxes Copy. This will make recalling of the
necessary features simpler when next used.
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Xerox Xerox Wide Format 6279% Printer/6622™ Printer

When using the Xerox 6279/6622 with the color enabled scanner, the following settings are
recommended for both color calibration and copying:

3-14

At the scanner, configure a new Mailbox at the scanner with exactly the same name as that
entered in the Mailbox field of the Accxes Copy scan settings. In this set-up the Mailbox name is,
Accxes Copy. This name is case sensitive.

In the Scan to Mailbox tab, set the following options:
e Rendering: Color 24-bit

e  File Format: Tiff / Single - page

e  Original Document Type: Photo (Halftone)

e  Compression: Packbits

In the Image Quality tab, set the following options:

e Density: 0

e Contrast: 0

e Sharpness: 0

e  Background Suppression: Off (Disabled)

In the Advanced Settings tab, set the following options:
e  Preview: Off

e  Resolution: 300dpi (Any higher can be used but will severely slow down calibration and
printing. It will also slow down the memory resources on the computer hosting Accxes Copy.)

e  Color Space: Standard (Do not use Adobe)

Save all the above options to a template and call it Accxes Copy. This will make recalling of the
necessary features simpler when next used.
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Xerox Wide Format Scan System

When using the Xerox Wide Format Scan System with color enablement, the following settings are
recommended for both color calibration and copying:

At the Xerox Wide Format Scan System, ensure the directory name used when selecting scan
mode is exactly the same as the name entered in the Mailbox field of the Accxes Copy scan
settings. In this set-up the Directory name is, Accxes Copy. This name is case sensitive.

In the scan mode, set the following options:
e Rendering: Color

e  Preview: Off

e  File Format: JPEG

e Compression: BEST IQ

e  Resolution: 300dpi (Any higher can be used but will severely slow down calibration and
printing. It will also slow down the memory resources on the computer hosting Accxes Copy.)

From the Menu button, go to CONFIGURATION > IMAGE ENHANCEMENT and set the following
option: ColorIQ: NONE

Note

When viewing the menu that contains the ColorIQ setting, you will also notice an option for
Dynamic Background Removal. Ignore the menu setting here because when scanning in, this is
automatically disabled.

Save all the above options to a template. This will make recalling of the necessary features simpler
when next used. Note that templates cannot include the menu change made to the ColorIQ
option, so ensure the customer is aware of changing this manually.
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Accxes Copy test configuration

e  Ensure the Accxes Copy application is started, the scan system and printer are powered on and
working correctly with a good quality media loaded in the printer. (This should be the same media

used in the color calibration task covered earlier.)

e At the scanner, enter the correct Mailbox/Directory name and scan modes for your scanner as
identified in the section in this document entitled, Xerox Scanner - Recommended Scan Settings.

e Scan a document of the type that is typically used for producing color copies.

e Following a short pause depending upon network connectivity and file size, a preview of the
document will appear in the Accxes Copy preview pane. If this is the first document, it should also
appear in the main view of the Accxes Copy UL If not, simply select the document in the preview
pane in order to select it.

¥ Xerox FreeFlow Accxes Copy

File Options Templates Help

1~ Documents -

Sample? tif

Scanner: Mot Connected Sampled: 586.74 » 418.97mm

-Set

.| Printer:

I QCopy Test Printer

Size:

[anre =] 1 ﬂ
Scale: i
Quaality: -

i Mormal s i

Notes

* A major benefit of Accxes Copy is that having made the initial scan, the document need
not be scanned again when choosing different print modes, quality settings, output sizes

and templates.

e  Depending upon the document type, the use of templates is recommended. Example
templates are listed later in this section and should be configured now, before

continuing this test.
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With the required image in the main view of the Accxes Copy UL, it is now that you make selections for
output quality, color controls and whether to use calibration and templates if available.

e Select a template according to the scanned document type.

o If your printer is a 7142, select ‘Normal’ as the Quality mode. If you have a non-Xerox printer,
ensure you select a print mode for which you have completed a calibration.

e  From the 'Options’ menu, select ‘Show Color Controls' in order to display the Color Adjustment
window, pictured below. The selections in the Color Adjustment window will display those that
were configured for the template. Manual adjustment can still be made if required.

Note

Any selections made within the Color Adjustment window will be used during the copy process,
whether the Show Color Controls option is enabled or not.

Colour Adjustment
Black Point
L e
White Paint
el S
Brightnesz
..... oo o
Srmoath Sharp
i
Detect | Reszet |

Having completed a print, if you wish Accxes Copy to make a suggested adjustment for your
document, select [Detect] and allow a couple of seconds for the software to react. Accxes Copy will
make an automatic adjustment based upon what it determines to be the preferred black and white
point.

You will notice other settings are available for Brightness and Sharpness. Experimentation is required to
observe the effect of changes made here.

e Inthe Size drop down window, ensure the option is set to 'ANY" and in the Scale drop down
window, ensure the option is set to 'Auto’.

e  Select the green print button and wait for the print process to complete.

e If you have a Draft mode available, change the print output quality to ‘Draft’.
e Inthe Color Adjustment window select [Detect].

e  Select the green print button and wait for the print process to complete.

e If you have a Best mode available, change the print output quality to ‘Best’.

e Inthe Color Adjustment window select [Detect].
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e  Select the green print button and wait for the print process to complete.

e  Compare all three copies to the original to determine the difference that can be made by using
the various print output quality options.

e  Select the Normal print mode and make at least two further copies to check/demonstrate
reduction and enlargement. Select the required output size in the Size drop down field and select
‘Auto’ in the Scale drop down field.

e  This concludes the Standard Installation for Accxes Copy.

Accxes Copy templates

When making copies, the color controls will have a direct impact on the copy quality and it is important
to understand that experimentation will be required in order to achieve the best results from various
document and media types. This section includes some sample templates based upon observations
made during various tests and will provide a good starting point.

Before proceeding, consider the following notes:

Color Calibration:

This is a useful tool and would usually be preferred for accuracy. However, it can be switched off
and this may produce a preferred neutral effect on gristles in solid area fills.

Adaptive White Point:

When scanning different media, the media white points can vary and the scanner can detect such
changes as background that may also be biased blue or pink. Closed loop calibration ensures any
detected background on the calibrated media is forced to white. However, you may have an
instance where the document you wish to copy contains light areas of image and has a white
point lighter than the printed media, which has been calibrated in Accxes Copy. Using closed loop
calibration there is a risk that light areas of image on the lighter document may be removed when
printing to a media with a lower white point. In such cases, turning Adaptive White Point on, will
produce a document with more background, but with the lighter areas preserved. In such cases,
the user can make further manual adjustments to white and black point to further enhance the

copy.

Color Controls (Incorporating Black Point, White Point, Brightness and Sharpness):

Within the controls, there is a ‘Detect’ button. Using this button is useful for checking
recommended Black and White points as detected by the software and helps check whether the
detected settings are vastly different to the recommended settings listed below. In addition, a
small Sharpness adjustment is recommended to enhance overall copy quality.
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The Calibration, Adaptive White Point and Show Color Controls options are located under the Options
menu in the Accxes Copy UL

In order to create templates perform the following activities:

Select the required options as detailed below.
Select 'Add’ from the Templates menu in the Accxes Copy UL
Enter the name for the required template (For example: Lines and Text, Maps, etc.) and select [OK].

In order to use the template, select the name of the template you require from the Templates
menu from the Accxes Copy UL You can still make manual changes to black point, white point,
print modes, etc.

Example Accxes Copy templates

Mark-ups and Line Drawings when using the Xerox Wide Format Scan System

Use Calibration: Checked

Adaptive White Point: Checked (But dependant upon specific document and copy media white
points)

Black Point: 25
White Point: 100
Sharpness: +1

Maps when using the Xerox Wide Format Scan System

e Use Calibration: Checked

e Adaptive White Point: Un-checked (But dependant upon specific document and copy media
white points)

e Black Point: 0
e  White Point: 100
e Sharpness: +1

Mark-ups and Line Drawings when using the Xerox 6604/6605 and Xerox 6279/6622

e Use Calibration: Checked

e Adaptive White Point: Un-checked (But dependant upon specific document and copy media
white points)

e Black Point: 11
e  White Point: 96
e Sharpness: +1

Maps when using the Xerox 6604/6605 and Xerox 6279/6622

Use Calibration: Checked

Adaptive White Point: Un-checked (But dependant upon specific document and copy media white
points)

Black Point: 3
White Point: 95
Sharpness: +1
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Appendix A

Scanning documents on the Xerox Wide Format
Scan System

The Xerox Wide Format Scan System is usually defaulted to produce copies. To produce a scanned
image file, the operator must press the [Mode] button on the scanner control panel. For standalone
scanners, the default will be scanning.

The control panel displays the last directory used to store scanned images. (This is the directory on the
Accxes controller used to spool the scanned image.) Whatever is entered here must be exactly the
same as what must be typed in the Directory field in the Source tab within the Settings menu of
Q-Indexer. This text is case sensitive in both the scanner and Accxes Indexer.

The operator can either accept this directory on the scanner by pressing the [Enter] button; or a new
directory can be selected by using the alphanumeric keypad on the scanner control panel. Remember
this must be matched in the Accxes directory field of Accxes Indexer.

The [Next] and [Previous] buttons on the scanner are used for either going back or forward a space.
The [Next] button must be used to move the cursor on a space if two adjacent characters have to be
entered using the same alphanumeric button. For example: 00 or AA, AB, etc. Some of the quality
settings on the scanner can be selected for use when scanning a document to file. For example: Mirror,
Invert and Contrast. The scanner uses Dynamic IQ, different threshold settings, auto image size detect
and auto centring. A full listing of the scanning options are explained in the scanner user guide.

The control panel displays the current resolution and can be changed to use either 75, 100, 200, 300 or
400 dpi depending upon the scan mode. Most archiving is produced at 200 dpi as this creates a good
compromise between file size and quality.

The resolution can be changed by using the [Next] and [Previous] buttons. Scanning at 200 dpi can
increase the scan speed on the scanner in some quality modes. For example: a scanner configured at 4
inches per second (ips) will increase in speed to 8 ips when scanning documents at 200 dpi in Normal
mode.

For the most productive indexing, documents should be scanned long edge first (LEF - landscape
orientation) and the title block trailing. With the correct settings as described in this guide, the title
block will be automatically viewed within Accxes Indexer to aid fast indexing. Some documents, such
as AO can only be fed into the scanner short edge first (SEF). In this case, Accxes Indexer image tools
can be used to rotate the image.

Scanning documents LEF on the Xerox Wide Format Scan System at a speed of 8 inches per second,
combined with the versatility of Accxes Indexer, produces archiving at some of the fastest speeds
possible.
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Appendix B

Configuring the Xerox Wide Format Scan
System for use with Accxes Indexer

Overview

The Xerox Wide Format Scan System provides several settings for creating scanned images and will
depend upon the current firmware version. Full details of these settings can be found in the scanner
User Guide. This appendix provides an overview of these settings and how they can affect scanning
with Indexer.

The settings for each of the scan modes can be set individually. Access to these settings on the scanner
varies depending upon the firmware version installed. The following will provide some basic
understanding of the modes. For information on how to access these modes, please consult the user
guide that came with the equipment, or the release notes relevant to any firmware upgrade that has
been made.

The following modes are available with FreeFlow Accxes firmware version 10 and scanner firmware
version 3.2.6:

Line - 1-bit black and white. For example, black lines and pencil will be reproduced as black.

Normal - Uses simple thresholding to produce a monochrome file with some gray scale recognition. For
example, black lines will be reproduced as black and pencil will be reproduced as gray scale.

Photo - 8-bit gray scale for monochrome photographs.

Color - 24-bit and Indexed Color options (Color enabled scanners only)

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy B-1
User Guide



Appendix B

Preview Mode

The scanner has the capability of generating low-resolution image previews as well as the actual
scanned file. Previews are normally enabled by default, and can be disabled by toggling the Preview
check box in the scan mode settings of the scanner control panel.

If previews are enabled, Accxes Indexer will display the low-resolution preview, not the real scanned
image. This is not normally desirable for monochrome scanning and should be disabled. However, in
color scanning mode, previews can bring a great speed enhancement, as Indexer does not have to
open the actual scanned image file, which will have a larger file size than monochrome images. If a
previewed document is not saved, the image file will not be retrieved from the scanner, again saving
time. See Appendix C on page C-1 for more details on color scanning configurations.

Note

In preview mode the initial view will always be of the whole drawing, and editing controls are
disabled. The quality of the previews may not be high enough to read title block information. The
actual image is retrieved from the scanner when the file is accepted, and a pause can be expected
at this point (the status bar will display the current activity).
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File formats

Accxes Indexer supports the following file formats:

Format/Compression Read Write 1bit 4bit 8bit 24bit

BMP X X X X X X

CALS

X X X
EPS X X X X X
CCITT G3 X X X
(Compression)

CCITT G4
(Compression)

x
x
x

HPGL, HPGL/2

JPEG

Adobe PDF

PostScript

X[ X | X[ X| X
X | X | X | X

TIFF X X X X

The Xerox Wide Format Scan System produces the following file formats:
Line - Tiff

Normal - Tiff, PDF & CALS (PDF scanning is available as standard on the scanner. Printing PDF depends
upon the PostScript option being installed on the Accxes controller.)

Photo - Tiff - Raw or Packbits compression

Color
Tiff - Packbits (sRGB, Adaptive Contrast & None)
Tiff - Index (CAD/GIS, Web, Perceptual & Default)
Tiff - Index ED (CAD/GIS, Web, Perceptual & Default)
JPEG - Best Compression (sRGB, Adaptive Contrast & None)
JPEG - Normal (sRGB, Adaptive Contrast & None)
JPEG - BestIQ (sRGB, Adaptive Contrast & None)
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Accxes Indexer color scanning support

From version 4.0.6, Accxes Indexer supports color scanning with the Xerox Wide Format Scan System,
with the color option installed. It should be noted that color scans are much larger than monochrome
scans, and a higher PC specification is required (see the section entitled System Requirements). Slower
operation should be expected when working with color scanned images.

Multi-page mode

Color images are not supported in Multi Page mode.

Color scanning mode

There are several options on the scanner that affect color files. The table below provides a guide to
setting these options for different applications.

Users are encouraged to experiment for their own requirements:

Requirement Recommended Options Indexer
Document . File . Palette
e Quality Format Compression (Index) Speed Notes
Image Best Large TIFF PACKBITS N/A Slow Preview mode
- recommended
Image V Good Medium | JPEG BEST IQ N/A Average | o improve
Image Good Smaller | JPEG Normal N/A Average performance,
and to handle
A1/Arch D and
larger.
CAD High Large TIFF PACKBITS N/A Slow Preview mode
Drawings may be
and Maps required for
A1/Arch D and
larger.
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Requirement Recommended Options Indexer
_I?;Fc)::ment Quality g:lzee IE:)lfmat Compression :’Icrl‘lsztxe) Speed Notes
CAD High Medium | TIFF INDEX Default Fast INDEX
Drawings CAD/GIS compression
and Maps Web reduces
Perceptual number of
(Depends colors, often
on colors leading to
in the better qulaity
document) on line
drawings.
Indexer will
operate faster
with INDEX
compression.
Mark-up High Small TIFF INDEX WEB Fast Thereis a
(Highlight) choice of four
CAD palettes.
drawings (CAD/GIS,
WEB,
Perceptual &
Default). The
WEB palette is
excellentwhen
few colors are
used.

Full sizes, speed, and resolution

File sizes in color mode can be very large, leading to slower performance. Reducing scanning resolution
can greatly improve speed, often showing little change in image quality. For example documents will
scan twice as fast at 200dpi than 400dpi, and files will be approximately Y of the size, depending upon
selected scan options. This means Q-Indexer could operate up to nearly 4 times faster at 200dpi than
400dpi.

Q-Indexer may not be able to view large scans (A1/Arch D or greater) at high resolutions as the images
can be in excess of 500MB. INDEX compression and/or preview mode should be used when this is
required.

Large scan files can take several minutes to transfer across the network. A T00Mbps network and a
switched hub are highly recommended. A switched hub provides the benefit of enabling images to be
transferred directly from the source to the destination with minimal effect on the network.
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Using Accxes Indexer with third-party
applications

Accxes Indexer can be used as a viewer through third-party applications such as Accxes Client Tools

(ACT) and Wide Format Scan System, which can be used as both a viewer and an editor.
Note

It is assumed that third-party applications are preinstalled and properly working on the same
system where the Accxes Indexer application is installed. It is the customer’s responsibility to
resolve any issues with third-party applications.

Configuring Accxes Client Tools as a viewer

To configure Accxes Client Tools as a viewer, perform the following:
1. On the Accxes Client Tools UI, select the Edit menu.
2. Select Configure Viewer.

3. From the Configure Viewer window, enter this path information: C:\Program Files\Xerox\Wide
Format\Xerox Wide Format FreeFlow Accxes Indexer\Indexer.exe.

In the Options field, enter -f.

Select the [OK] button.

Select Document Submit and add a document.

Select the document and right click on it.

Select Launch Viewer to view the document in Accxes Indexer.

® N v

Configuring Wide Format Scan System as an editor/viewer

Create a new profile enabling the Wide Format Scan System to be an editor by performing the
following:

1. Launch Accxes Indexer.

From the Accxes Indexer main menu, select the Source tab.

In the Profile field, enter a name for the profile; for example: wfss_viewer.

From the Advanced tab, check Enable Editor.

Browse to the path: C:\Program Files\Xerox Corporation\Wide Format Scan Service\Plugin.

i wN
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10.
11.
12.
13.

E-2

Select the PictLoader.exe file.

Select Open.

If that file is not shown, select All Programs from the Files of type drop-down box; it should now be
shown.

Note

The Edit button is only available on the user interface after an editor is enabled and the editor is
selected in the path field.

Continue to setup the profile including the location from where images will be sourced.

Select OK in the Accxes Indexer Settings window.

Launch Accxes Indexer and select the wfss_viewer profile.

Ensure that an image is displayed in the Viewer.

Select the Edit button in the lower right of the Accxes Indexer application.

If a confirmation window opens, select OK or Cancel.

The image should be displayed in the Wide Format Scan System viewer if OK was clicked.

Xerox Wide Format FreeFlow Accxes Indexer/FreeFlow Accxes Copy
User Guide



Appendix F

Accxes Copy image editing guidelines

After calibration

After calibrating, make a copy of the calibration target page; this is your starting point. The calibration
target page should be an exact match to the original target. If this is not the case, try recalibrating.

Adaptive white point

Adaptive white point attempts to keep the background white while preserving light colors from the
original documents. This is very subjective and some users prefer the result with Adaptive white point
disabled.

Color adjustment - black and white point

The black point adjustment enhances the black colors to appear solid rather than gray. The white point
adjustment cleans up the blue, gray, and yellow backgrounds. Refer to the following information:

e To enhance technical documents, move the smooth/sharp adjustment toward Sharp by 1 or 2
increments.

e  For best quality for graphical documents, move the smooth/sharp adjustment by 1 or 2
increments.

e Using a combination of adaptive white point and black and white point adjustment may visually
improve the document; however, it does not provide the most accurate color.

When copying color images, such as graphic communications documents or photographs, the
following should be considered:

e Use asuitable target media and print mode:
e Anexample is a good gloss or satin media with high color gamut and ink limit

e Create a suitable new print mode in the print driver; one appropriate to the type of media
and application (for example, photographs)

e Create a new calibration for this media and print mode combination
e Disable Adaptive White Point
e  For the most accurate color, set black point to zero (0), and set the white point to 100

e Toincrease the contrast at the expense of color accuracy, adjust the black and white points
evenly; for example: black point = 5; white point = 95
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